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PPrreeffaaccee  

This document provides step-by-step instructions to install the Oracle Financial Services 

International Financial Reporting Standards Application Pack (OFS IFRS) 8.0.3.0.0 Minor 

Release. 

This chapter discusses the following topics: 

 Audience 

 How this Guide is Organized 

 Recommended Environment 

 Related Documents 

 Conventions and Acronyms 

Audience 

The OFS IFRS pack Installation and Configuration Guide is intended for administrators and 

implementation consultants who are responsible for installing and maintaining the application 

pack components.  

The document assumes you have experience in installing Enterprise components. Basic 

knowledge about the OFS IFRS pack components, OFSAA Architecture, UNIX commands, 

Database concepts, and Web Server/ Web Application Server is recommended. 

PPrreerreeqquuiissiitteess  ffoorr  tthhee  AAuuddiieennccee  

The document assumes that you have experience in installing Enterprise components and basic 

knowledge about the following is recommended.  

The following are the expected preparations from the administrator before starting the actual 

installation: 

 Oracle Financial Services Advanced Analytical Applications Infrastructure pack 

components 

 OFSAA Architecture 

 UNIX Commands 

 Database Concepts 

  Web Server/Web Application Server  

How this Guide is Organized 

The OFS IFRS pack Installation and Configuration Guide includes the following topic: 
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 OFS IFRS Release 8.0.3.0.0. 

RReeccoommmmeennddeedd  EEnnvviirroonnmmeenntt  

The infrastructure application has been tested with Microsoft Internet Explorer™ browser. For 

best viewing of Infrastructure pages, set the screen resolution to a minimum resolution of 1024 x 

768 pixels. 

RReellaatteedd  DDooccuummeennttss  

For more information, refer to the OFS IFRS Pack 8.0.3.0.0 documents available in OHC 

Documentation Library. 

 Oracle Financial Services International Financial Reporting Standards Application Pack 

Installation Guide 8.0.0.0.0 

 Oracle Financial Services Loan Loss Forecasting and Provisioning User Guide 

8.0.3.0.0 

CCoonnvveennttiioonnss  aanndd  AAccrroonnyymmss  

Conventions Description 

Actions are indicated in Bold. 

Command or query is indicated in Courier New font. 

AIX Advanced Interactive eXecutive 

OFSAAI Oracle Financial Services Analytical Applications Infrastructure 

OFS AAAI Oracle Financial Services Advanced Analytical Applications Infrastructure 

Application Pack 

RHEL Red Hat Enterprise Linux 

ML Maintenance Level  

Atomic Schema Database schema where the application data model is uploaded. 

Config Schema Database schema which contains setup related configurations and metadata. 

DEFQ Data Entry Forms and Queries 

DML Data Manipulation Language 

EAR Enterprise Archive 

EJB Enterprise JavaBean 

ERM Enterprise Resource Management 

http://docs.oracle.com/cd/E60529_01/homepage.htm
http://docs.oracle.com/cd/E60529_01/homepage.htm
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Conventions Description 

FTP File Transfer Protocol 

GUI Graphical User Interface 

HTTPS Hypertext Transfer Protocol Secure 

J2C J2EE Connector 

J2EE Java 2 Enterprise Edition 

JDBC Java Database Connectivity 

JDK Java Development Kit 

JNDI Java Naming and Directory Interface 

JRE Java Runtime Environment 

JVM Java Virtual Machine 

OHC Oracle Help Center 
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11  OOFFSS  IIFFRRSS  PPaacckk  RReelleeaassee  88..00..33..00..00  

This Minor Release of Oracle Financial Services International Financial Reporting Standards 

Application Pack (OFS IFRS) is cumulative and includes all enhancements and bug fixes done 

since the OFS IFRS Application Pack v8.0.0.0.0 GA release. For more information, refer the 

Oracle Financial Services IFRS Release 8.0.0.0.0 Installation Guide in OHC Documentation 

Library. 

11..11  SSuuppppoorrtteedd  SSooffttwwaarree  VVeerrssiioonnss  

You can refer to the OFSAA Technology Matrix 8.0.3.0.0 in OHC Documentation Library to know 

more about the software versions that are supported by this release of OFS IFRS. 

11..22  PPrree  IInnssttaallllaattiioonn  RReeqquuiirreemmeennttss  

 You should have installed either OFS IFRS Application Pack version 8.0.0.0.0 or OFS IFRS 

Application Pack version 8.0.2.0.0 (using Full Installer).  

NOTE:  You can refer to Technology Matrix for Hardware and Software Requirements. 

 OFS IFRS Application Pack 8.0.3.0.0 installer update patch has been regularized with Bug 

23251358-Object Registration is failing with duplicate Constraint Names. This has been 

bundled as a utility called Update Constraints utility and is executed as part of the 8.0.3.0.0 

patch installation.   

 It is advised to take a backup of the atomic schema for each Information Domain in the 

OFSAA instance before applying the patch.  

 Execution of the utility is a memory intense process as the entire steps involved for 

performing a full model upload is carried out as part of the utility for each of the 

Infodom.  The OFSAA installation server needs to have twice the allocated memory, 

which is assigned using parameter X_ARGS_APPS.  

 The utility creates three temporary tables- REV_TAB_CONSTRAINTS_U, 

REV_TAB_REF_CONSTRAINTS_U, and REV_TAB_CONSTRAINT_COLUMNS_U. If the 

atomic schema has any of these tables already created for a different purpose, take a 

backup and drop/ rename. 

 As in the model upload process, for the applications that follow logical model upload like 

OFS_AML in BD pack, the utility does not play any role, since the persistence of the 

model is outside the purview of the utility. Any similar cases, which involve only logical 

model upload should be considered and taken care of by the user. 

For more information about the utility execution and log files information, see the 

Update Constraints Utility section. 

http://docs.oracle.com/cd/E60529_01/homepage.htm
http://docs.oracle.com/cd/E60529_01/homepage.htm
http://docs.oracle.com/cd/E55339_01/homepage.htm
http://docs.oracle.com/cd/E55339_01/homepage.htm
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 Upgrade of IFRS Application Pack to 8.0.3.0.0 mandates upgrade of Oracle Financial 

Services Asset Liability Management Application Pack and Oracle Financial Services 

Profitability Application Pack to 8.0.3.0.0 release. Until these dependent Application Packs 

are upgraded, the respective Applications within these packs will be disabled from the UI. 

 The PATH variable in the .profile file should be set to include the Java Runtime 

Environment absolute path. The path should include the java version (java 6, java 7, or java 

8) based on the configuration. 

 Download the one-off patch 24412483 from My Oracle Support. 

 Download the one-off patch 25777667 from My Oracle Support. 

NOTE:  Ensure that the ACL feature is not set in Linux Server, during installation. 

11..33  HHooww  ttoo  AAppppllyy  TThhiiss  MMiinnoorr  RReelleeaassee??  

11..33..11  IInnssttaalllliinngg  OOFFSS  IIFFRRSS  

Refer to the following instructions to download, extract, install, and configure this Minor Release. 

1. Login to https://support.oracle.com/ and search for 24438725 under the Patches & 

Updates tab. 

2. Download the OFS IFRS Application Pack v8.0.3.0.0 archive file and copy it to your 

OFSAA server in Binary mode. 

NOTE:  The archive files are different for every operating system like AIX, Solaris, and 

RHEL/Oracle Linux. 

3. Log in to the OFSAA Server. 

4. Shut down all the OFSAAI Services. For more information, refer to the Start/Stop 

Infrastructure Services section in Oracle Financial Services IFRS Release 8.0.0.0.0 

Installation Guide in OHC Documentation Library. 

5. Assign WRITE permission to the files/folders such as common scripts, 

EXEWebService, ficapp, ficweb, and ficdb in the $FIC_HOME folder by executing the 

command: 

chmod -R 750 $FIC_HOME 

6. If you have Unzip utility, skip to the next step. Download the Unzip utility (OS-specific) 

and copy it in Binary mode to the directory that is included in your PATH variable, 

typically $HOME path or directory in which you have copied the 8.0.3.0.0. 

 Uncompress the unzip installer file using the command: 

uncompress <unzip utility filename> 

https://support.oracle.com/
https://support.oracle.com/
https://support.oracle.com/
http://docs.oracle.com/cd/E60529_01/homepage.htm
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NOTE:  In case you notice an error message “uncompress: not found [No 

such file or directory]” when the package is not installed, contact your 

UNIX administrator. 

 Give EXECUTE permission to the file using the command: 

chmod 751 OFS_IFRS_80300_<OperatingSystem>.zip. 

7. Extract the contents of the 8.0.3.0.0 archive file using the command: 

unzip_<os> -a <name of the file to be unzipped> 

NOTE:  The above “-an” option is mandatory to unzip the archive file. For example: 

unzip_aix -a OFS-IFRS_80300_<OperatingSystem>.zip 

8. Give EXECUTE permission to the archive file. Navigate to the path 

OFS_IFRS_80300_<OperatingSystem>.zip and execute the command:  

chmod 750 OFSAAIUpdate.sh 

9. Configure the Param.conf file present under OFS_IFRS_PACK/OFS_IFRS/conf folder, 

as follows: 

 Model Upload Process: Enter either 0 or 1. 

 0  - Skip Model Upload 

 1 - Trigger Model Upload 

 If you have selected 1 in the previous step, select the option of the type of Model 

upload as either 0 or 1. 

 0 - Released Data Model  

 1 - Customized Data Model  

 If you have selected 1 in the previous step, provide the inputs for the Data Model 

Name and the Path of Data Model. 

10. Execute OFSAAIUpdate.sh file using the following command: 

./OFSAAIUpdate.sh 

Verify if the Minor Release is applied successfully by checking the following log files 

generated in the installation folder: 

 <IFRS_Patch_Installer_Folder>/OFS_IFRS_PACK/logs/OFSAAIUpdate.log 

 <IFRS_Patch_Installer_Folder>/OFS_IFRS_PACK/OFS_IFRS/logs/<log> 

You can ignore ORA-00001, ORA-00955, ORA-02260, and ORA-01430 errors in the 

log file. In case of any other errors, contact Oracle Support. 

https://support.oracle.com/
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11. Install the one-off patch 24412483. For more details, refer the Read Me available with 

the patch. 

12. Install the consolidated one-off patch 25777667. Refer to the Readme available with the 

patch for further instructions on installing the patch. 

13. Verify the Update.log file located at 

$FIC_HOME/utility/UpdateConstraints/logs folder which is created by 

Update Constraint utility. 

Execution status information of the utility is available against each Information domain. 

For success, “Update successful” message is displayed. If it is successful, verify the 

following references for new constraint names: 

 ftpshare/<INFODOM>/erwin/fipxml/<INFODOM>_DATABASE.xml 

 Constraint scripts under ftpshare/<INFODOM>/erwin/scripts/table 

 Constraint scripts under ftpshare/<INFODOM>/scripts 

 Object registration tables for constraints, REV_TAB_CONSTRAINTS, 

REV_TAB_REF_CONSTRAINTS, REV_TAB_CONSTRAINT_COLUMNS. 

 Oracle Data Dictionary in the respective atomic schema for each Infodoms. 

In case of errors in the Update.log file, identify the failed Infodoms. Then troubleshoot 

and execute the standalone utility for the failed Infodoms. See How to execute the 

Update Constraints Utility section. 

14. After successful installation of this Minor Release, perform the following steps: 

 Clear the application cache. Navigate to the following path depending on the 

configured web application server and delete the files. 

 Tomcat: 

<Tomcat installation folder>/work/Catalina/localhost/<Application 

name>/org/apache/jsp 

 Weblogic: 

<Weblogic installation location>/domains/<Domain name>/servers/<Server 

name>/tmp/_WL_user/<Application name>/qaelce/jsp_servlet 

 Websphere: 

<Websphere installation directory>/AppServer/profiles/<Profile 

name>/temp/<Node name>/server1/<Application name>/<.war file name> 

15. Add umask 0027 in the .profile of the UNIX account which manages the WEB 

server to ensure restricted access permissions. 

16. Generate the application EAR/WAR file and redeploy the application onto your 

configured web application server. For more information on generating and deploying 
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EAR / WAR file, refer to the Post Installation Configuration section in Oracle Financial 

Services IFRS Release 8.0.0.0.0 Installation Guide in OHC Documentation Library. 

17. After the successful installation of the Minor Release, restart all the OFSAAI services. 

For more information, refer to the Start/Stop Infrastructure Services section in Oracle 

Financial Services IFRS Release 8.0.0.0.0 Installation Guide in OHC Documentation 

Library. 

11..44  UUppddaattee  CCoonnssttrraaiinnttss  UUttiilliittyy  

This utility applies a new naming convention to constraints (PK and FK) to resolve the following 

issues: 

 For tables with similar names which are relatively long (>27 characters) where the initial 

few characters differ (for example, STG_COMMON_ACCOUNT_SUMMARY, 

FCT_COMMON_ACCOUNT_SUMMARY), the constraint names get generated as 

same causing an Oracle error of duplicate constraints.  

 When the number of foreign keys for a table is more than 100, the length of the 

constraint name exceeds the permissible limits allowed by Oracle Database. 

The new naming convention has the following logic.  A Unique ID gets generated for each data 

model entities.  The new constraint name will be generated by appending the unique ID with ‘FK’ 

or ’PK’ (along with a sequence for FK). For example, PK on DIM_ACCOUNT will be formed as 

PK_101, where 101 is the unique id of DIM_ACCOUNT. Similarly, FKs on 

FCT_ACCOUNT_SUMMARY will be FK_206_01, FK_206_02, FK_206_03, FK_206_04, where 

206 is the unique id of FCT_ACCOUNT_SUMMARY and the table has 4 FKs. 

This utility gets executed as part of the OFSAAI 8.0.3.0.0 patch installation. After the successful 

installation of the OFSAAI 8.0.3.0.0 installer patch, verify the Update.log file located at 

$FIC_HOME/utility/UpdateConstraints/logs folder that is created by Update 

Constraint utility. Else, the value of AAI_MU_UTIL_UPDATE_CONS. V_FLAG_VALUE of the 

Config Schema table. If its value is ‘N’ against an Infodom, it is identified as a failure.  

In case of errors, identify and troubleshoot the failed Infodoms. Once you have completed the 

troubleshooting, execute the standalone utility for the failed Infodoms. 

11..44..11  HHooww  ttoo  EExxeeccuuttee  tthhee  UUttiilliittyy  

Utility performs the backup of the following files under ftpshare/<INFODOM>_encon_bkp but 

restoration is not done. 

 ftpshare/<INFODOM>/erwin/fipxml/<INFODOM>_DATABASE.xml 

 Constraint scripts under ftpshare/<INFODOM>/erwin/scripts/table 

 Constraint scripts under ftpshare/<INFODOM>/scripts 

http://docs.oracle.com/cd/E60529_01/homepage.htm
http://docs.oracle.com/cd/E60529_01/homepage.htm
http://docs.oracle.com/cd/E60529_01/homepage.htm
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To execute the utility, perform the following steps: 

1. Navigate to $FIC_HOME/utility/UpdateConstraints/bin/ folder and grant 

RWX (755) permissions for all executables (.sh files). 

2. Execute the utility manually for each of the failed information domains. 

$FIC_HOME/utility/UpdateConstraints/bin/execute.sh $INFODOM 

3. If the process is successful, verify the following references for new constraint names: 

 ftpshare/<INFODOM>/erwin/fipxml/<INFODOM>_DATABASE.xml 

 Constraint scripts under ftpshare/<INFODOM>/erwin/scripts/table 

 Constraint scripts under ftpshare/<INFODOM>/scripts 

 Object registration tables for constraints, REV_TAB_CONSTRAINTS, 

REV_TAB_REF_CONSTRAINTS, REV_TAB_CONSTRAINT_COLUMNS. 

 Oracle Data Dictionary in the respective atomic schema for each Infodoms.  

4. In case of failure, refer to the utility’s log and identify the cause of the failure. Resolve 

the issues before proceeding with the re-run of the utility. For more queries, contact 

Oracle Support Services. 

11..44..22  TTrroouubblleesshhoooottiinngg  

Utility goes through six different steps, which can be traced with the below messages.  

NOTE:  At every stage identify the cause of the failure and resolve the issues before 

proceeding with the re-run of the utility: 

Steps Description Action to be taken 
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Steps Description Action to be taken 

1 Generate Scripts and updating 

DATABASE.XML 

Step 1:  

Restore the file backed up at 

ftpshare/<INFODOM>_encon_bkp/erwin/fipxml/<INFODOM>_DATAB

ASE.xml to the destination 

ftpshare/<INFODOM>/erwin/fipxml/<INFODOM>_DATABASE.xml. 

Step 2:  

Restore the folders backed up at 

ftpshare/<INFODOM>_encon_bkp/erwin/scripts/table to the 

destination folder ftpshare/<INFODOM>/erwin/scripts/table.  

Step 3:  

Restore the folders backed up at 

ftpshare/<INFODOM>_encon_bkp/scripts to the destination folder 

ftpshare/<INFODOM>/scripts. 

Step 4:  

Re-run the utility. 

2 Triggering Object Registration Step 1:  

Restore the file backed up at 

ftpshare/<INFODOM>_encon_bkp/erwin/fipxml/<INFODOM>_DATAB

ASE.xml to the destination 

ftpshare/<INFODOM>/erwin/fipxml/<INFODOM>_DATABASE.xml. 

Step 2:  

Restore the folders backed up at 

ftpshare/<INFODOM>_encon_bkp/erwin/scripts/table to the 

destination folder ftpshare/<INFODOM>/erwin/scripts/table.  

Step 3:  

Restore the folders backed up at 

ftpshare/<INFODOM>_encon_bkp/scripts to the destination folder 

ftpshare/<INFODOM>/scripts. 

 Step 4:  

Re-run the utility. 
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Steps Description Action to be taken 

3 Gathering information about 

previous constraint names 

Step 1:  

Restore the file backed up at ftpshare/<INFODOM>_encon_bkp/ 

erwin/fipxml/<INFODOM>_DATABASE.xml to the destination 

ftpshare/<INFODOM>/erwin/fipxml/<INFODOM>_DATABASE.xml. 

Step 2:  

Restore the folders backed up at 

ftpshare/<INFODOM>_encon_bkp/erwin/scripts/table to the 

destination folder ftpshare/<INFODOM>/erwin/scripts/table.  

Step 3:  

Restore the folders backed up at 

ftpshare/<INFODOM>_encon_bkp/scripts to the destination folder 

ftpshare/<INFODOM>/scripts. 

Step 4:  

Re-run the utility. 
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Steps Description Action to be taken 

4 Alter constraints Step 1:  

Execute the following statements to drop the backup tables in Atomic 

Schema:  

Drop table REV_TAB_CONSTRAINTS_U; 

Drop-Table REV_TAB_REF_CONSTRAINTS_U ;  

Drop table REV_TAB_CONSTRAINT_COLUMNS_U; 

Step 2:  

Restore the file backed up at 

ftpshare/<INFODOM>_encon_bkp/erwin/fipxml/<INFODOM>_DATAB

ASE.xml to the destination 

ftpshare/<INFODOM>/erwin/fipxml/<INFODOM>_DATABASE.xml. 

Step 3:  

Restore the folders backed up at 

ftpshare/<INFODOM>_encon_bkp/erwin/scripts/table to the 

destination folder ftpshare/<INFODOM>/erwin/scripts/table.  

Step 4:  

Restore the folders backed up at 

ftpshare/<INFODOM>_encon_bkp/scripts to the destination folder 

ftpshare/<INFODOM>/scripts. 

Step 5:  

Modify r_rename_cons.sql that is available in the   

$FIC_HOME/utility/UpdateConstraints/Scripts/<INFODOM> 

folder by adding semicolon at the end of each line.  

Step 6:  

Execute the file r_rename_cons.sql in the Infodom Atomic Schema.  

Note: Ignore any ORA errors related to ‘constraint does not exist’. 

Step 7:  

Re-run the utility. 
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Steps Description Action to be taken 

5 Clear data of previous constraints This can be considered as a successful case. However, the user needs 

to execute the following SQL commands. 

Step 1:  

Execute the following statements to drop the backup tables in Atomic 

Schema:  

Drop table REV_TAB_CONSTRAINTS_U; 

Drop-Table REV_TAB_REF_CONSTRAINTS_U ;  

Drop table REV_TAB_CONSTRAINT_COLUMNS_U; 

Step 2 :  

Execute the statement in Configuration Schema, after replacing 

<INFODOM> with the respective information domain: 

UPDATE aai_mu_util_update_cons SET 

V_FLAG_VALUE='Y',V_UPDATE_DATE=SYSDATE where 

DSNID='<INFODOM>' 

6 Update Successful - 
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11..55  SSaannddbbooxx  RReessaavvee  UUttiilliittyy  

A utility is provided to regenerate the CONSTRAINTS.XML as per the changes done as part of 

Update Constraints utility. The constraint XML is required for the sandbox data population which 

will store the foreign key names of all the tables.  

The XML files which will be re-generated are: 

ftpshare/<SANDBOXINFODOM>/erwin/scripts/sandbox/CONSTRAINTS.xml 

ftpshare/<SANDBOXINFODOM>/erwin/scripts/sandbox/<TABLE_NAME>.xml 

11..55..11  PPrreerreeqquuiissiitteess  

Update Constraints utility should have been run successfully on all the sandbox and production 

Infodoms. 

11..55..22  HHooww  ttoo  RRuunn  tthhee  UUttiilliittyy  

1. Navigate to $FIC_HOME/utility/sandboxutil/bin folder and grant RWX (755) 

permissions for all executables (.sh files). 

2. Execute the utility using the following command: 

./updatesandbox.sh 

3. Verify logs from $FIC_HOME/utility/sandboxutil/bin/nohup.out folder. 

4. If the process is successful, verify the following references for new constraint names: 

ftpshare/<SANDBOXINFODOM>/erwin/scripts/sandbox/CONSTRAINTS.xml 

ftpshare/<SANDBOXINFODOM>/erwin/scripts/sandbox/<TABLE_NAME>.xml 

5. In case of failure, refer the utility's log and restore the backups for the file system. 

Execute the utility for the failed infodoms one by one using the following command: 

$FIC_HOME/utility/sandboxutil/bin/updatesandbox.sh $INFODOM. 

NOTE:  Utility does the backup of 

ftpshare/<SANDBOXINFODOM>/erwin/scripts/sandbox folder as 

ftpshare/<SANDBOXINFODOM>/erwin/scripts/sandbox_bkp, but 

restore is not done. Restore should be done manually in case of any failure. 

The backup folder will be created in the app ftpshare area. In case of any 

failure, the backup has to be replaced in the db ftpshare area also. 

For more queries, contact Oracle Support Services. 
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11..66  UUppddaattee  EETTLLRReeppoossiittoorryy..xxmmll  FFiillee  

1. Shut down all OFSAAI Services. For more information, refer to the Start/Stop 

Infrastructure Services section in Oracle Financial Services IFRS Release 8.0.0.0.0 

Installation Guide in OHC Documentation Library. 

2. Take a backup of the file ETLRepository.xml, present in the location, 

$FIC_HOME/ftpshare/etlapphome/. 

3. Remove the following entry from the file ETLRepository.xml file: 

<DEFINITION ID="T2T_EMBEDDED_OPTIONS_SCH" ISLOOKUP="FALSE" 

LOADTYPE="TABLE_LOAD" MEMORYLOAD="FALSE" OWNER_INFODOM="FUSION" 

TYPE="EXTRACT"> 

<PROPERTIESCREATED>YES</PROPERTIESCREATED> 

<FTPSTATUS>YES</FTPSTATUS> 

<CREATEDBY>APPUSER</CREATEDBY> 

<CREATETIME>2012/10/4 01:05:27 AM</CREATETIME> 

<LASTMODIFIEDBY>APPUSER</LASTMODIFIEDBY> 

<LASTMODIFIEDTIME>2012/10/4 01:05:27 AM</LASTMODIFIEDTIME> 

<MAPPING> 

<INFODOMS> 

<INFODOM CTL_OR_FMT="NO" FTPSTATUS="YES" ID="FUSION"> 

   <TABLES> 

        <TABLE ID="FSI_D_EMBEDDED_OPTIONS_SCH"/> 

    </TABLES> 

</INFODOM> 

</INFODOMS> 

</MAPPING> 

</DEFINITION> 

4. Restart all OFSAAI services. For more information, refer to the Start/Stop Infrastructure 

Services section in Oracle Financial Services IFRS Release 8.0.0.0.0 Installation Guide 

in OHC Documentation Library. 

 

http://docs.oracle.com/cd/E60529_01/homepage.htm
http://docs.oracle.com/cd/E60529_01/homepage.htm


  OFS IFRS 8.0.3.0.0 Installation Guide 

 

19 

11..77  AAddddiittiioonnaall  CCoonnffiigguurraattiioonnss  

11..77..11  CCoonnffiigguurraattiioonnss  ffoorr  BBiigg  DDaattaa  PPrroocceessssiinngg  

You can refer to the Configurations for Big Data Processing section in the OFS Advanced 

Analytical Applications Infrastructure Application Pack Installation and Configuration Guide 

v8.0.2.0.0.  

11..77..22  CCoonnffiigguurraattiioonnss  ffoorr  EEnntteerrpprriissee  MMooddeelliinngg  

You can refer to the Oracle Financial Services Analytical Applications Infrastructure Applications 

Infrastructure Administration User Guide for information on configuration for Enterprise Modeling.  

11..77..33  CCoonnffiigguurraattiioonn  ffoorr  TToommccaatt  

You can refer to the Oracle Financial Services Analytical Applications Infrastructure Applications 

Infrastructure Administration User Guide for information on configuration for Tomcat. 

11..77..44  CCoonnffiigguurraattiioonnss  ffoorr  IInnlliinnee  PPrroocceessssiinngg  EEnnggiinnee  ((IIPPEE))  

You can refer to the Oracle Financial Services Analytical Applications Infrastructure Applications 

Infrastructure Administration User Guide for information on configuration for IPE. 

11..77..55  CCoonnffiigguurraattiioonnss  ffoorr  PPrroocceessss  MMooddeelliinngg  FFrraammeewwoorrkk  

You can refer to the Oracle Financial Services Analytical Applications Infrastructure Applications 

Infrastructure Administration User Guide for information on configuration for the Process 

Modeling Framework.  

11..77..66  CCoonnffiigguurraattiioonnss  ffoorr  FFoorrmmss  MMaannaaggeerr  

You can refer to the Oracle Financial Services Analytical Applications Infrastructure Applications 

Infrastructure Administration User Guide for information on configuration for Forms Manager. 

11..77..77  CCoonnffiigguurraattiioonnss  ttoo  DDeeppllooyy  tthhee  LLLLFFPPBBII  AApppplliiccaattiioonn  

The following are the steps to configure the LLFPBI Analytics:  

Before you begin this process, ensure that Oracle Business Intelligence (Version 11.1.1.7.1) 

installation is completed and is available. 

1. Set the <Oracle BI Instance Home> directory. 

For example: /u01/OBIEE11G/instances/instance1 

2. Start WebLogic AdminServer.  

a. Set the <BI Domain Home> directory. 

http://docs.oracle.com/cd/E60058_01/PDF/8.0.2.x/8.0.2.0.0/ig_ofs_aaai_app_pack.pdf
http://docs.oracle.com/cd/E60058_01/PDF/8.0.2.x/8.0.2.0.0/ig_ofs_aaai_app_pack.pdf
http://docs.oracle.com/cd/E60058_01/PDF/8.0.2.x/8.0.2.0.0/ig_ofs_aaai_app_pack.pdf
http://docs.oracle.com/cd/E60058_01/PDF/8.0.0.x/8.0.0.0.0/OFSAAI_Administration_Guide_8.0.pdf
http://docs.oracle.com/cd/E60058_01/PDF/8.0.0.x/8.0.0.0.0/OFSAAI_Administration_Guide_8.0.pdf
http://docs.oracle.com/cd/E60058_01/PDF/8.0.0.x/8.0.0.0.0/OFSAAI_Administration_Guide_8.0.pdf
http://docs.oracle.com/cd/E60058_01/PDF/8.0.0.x/8.0.0.0.0/OFSAAI_Administration_Guide_8.0.pdf
http://docs.oracle.com/cd/E60058_01/PDF/8.0.0.x/8.0.0.0.0/OFSAAI_Administration_Guide_8.0.pdf
http://docs.oracle.com/cd/E60058_01/PDF/8.0.0.x/8.0.0.0.0/OFSAAI_Administration_Guide_8.0.pdf
http://docs.oracle.com/cd/E60058_01/PDF/8.0.0.x/8.0.0.0.0/OFSAAI_Administration_Guide_8.0.pdf
http://docs.oracle.com/cd/E60058_01/PDF/8.0.0.x/8.0.0.0.0/OFSAAI_Administration_Guide_8.0.pdf
http://docs.oracle.com/cd/E60058_01/PDF/8.0.0.x/8.0.0.0.0/OFSAAI_Administration_Guide_8.0.pdf
http://docs.oracle.com/cd/E60058_01/PDF/8.0.0.x/8.0.0.0.0/OFSAAI_Administration_Guide_8.0.pdf
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i. For Example: 

/u01/OBIEE11G/user_projects/domains/bifoundation_domain 

b. Navigate to <BI Domain Home >/bin and execute the following command: 

nohup ./startWebLogic.sh & 

NOTE:  Bringing up this service may take a few minutes depending on your 

environment. Check the logs using the command: 

tail –f nohup.out 

3. Start Node Manager.  

a. Set the < WebLogic Server Home > directory>.  

For example: /u01/OBIEE11G/wlserver_10.3 

b. Navigate to <WebLogic Server Home>/server/bin and execute the following 

command: 

nohup ./startNodeManager.sh & 

4. Start WebLogic Managed Server (bi_server1).  

a. Login onto http://localhost:7001/console using your Administrator credentials 

created during platform install (Replace the hostname based on your setup).  

b. Under the Environment tab, click the Servers link. 

 

The bi_server1 displays the shutdown state at this point. 
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c. Click the Control tab.  

d. Select the bi_server1 line by clicking on the left tick box.  

e. Click the Start button at the top of the list and confirm starting this service. 

 

f. The state will update to the “RUNNING” mode after a few minutes. 

5. Start OBIEE services and login  

a. Starting services From EM screen: 

i. Log in to the EM administration screen using the URL: http://localhost:7001/em 

(Replace the hostname and port number based on your setup). Use the login 

you created in BIEE installation to log in.  

ii. Expand the 'Business Intelligence' node on the left and choose 

Coreapplication.  

 

iii. Click the Overview Tab. 
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iv. Click Restart (or Start) under the Manage System section.  

v. Click Yes on the dialog box to confirm the action. Wait for a message that 

confirms the successful restart. 

b. If the start process using EM is not successful and returning an error about 

OPMNCTL not up, follow the starting process with OPMNCTL.  

i. Open a command prompt, navigate to <Oracle BI Instance Home>/bin.  

ii. Execute the command ./opmnctl status. This displays the status of all the 

OBIEE core services  

iii. Execute the command ./opmnctl startall or ./opmnctl stopall depending on 

your requirement. 

6. Deploy RPD and web catalog file(s).  

a. Navigate to folder $FIC_HOME/LLFP_DASHBOARDS/repository/ which contains 

LLFPBI.rpd file and $FIC_HOME/LLFP_DASHBOARDS/catalog/ which contains 

LLFPBI.catalog file.  

i. Login to OBIEE – Enterprise Manager URL (http://<ip address>:<port>/em).  

ii. Click on core application from the Business Intelligence tab on the left-hand 

side.  

iii. Under core application, select the Deployment tab and click the Lock and 

Edit Configuration button located below the title core application. The 

following screen is displayed: 
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iv. RPD Deployment: Select the Browse button available under the Upload BI 

Server Repository section and select LLFPBI.rpd file from the local folder. 

Enter the Repository password ‘Administrator1’.  

v. Web catalog Deployment:  

 Create a new web catalog folder for the LLFPBI application through the 

Enterprise Manager of OBIEE. 

 Set the Catalog Location available under ‘BI Presentation Catalog’ as 

$ORACLE_INSTANCE/bifoundation/OracleBIPresentationServicesComp

onent/$COM PONENT_NAME/catalog/LLFPBI.  

 Click Apply and then click Activate changes. The following pop up is 

displayed after successful activation.  

 

 Click the Close button and switch to the Capacity management tab.  

 Restart the presentation services. Under the System Components 

Availability, select Presentation Services and click on Restart Selected 

option.  
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vi. Once the Presentation Service is restarted, it displays the pop up notifying the 

successful restart. Click Close.  

vii. Verify that the new folder structure is created in the system. It can be found 

under path: <Oracle BI Instance Home> 

\bifoundation\OracleBIPresentationServicesComponent\coreapplication_obips1

\catalog\LLFPBI 

viii. This LLFPBI folder will be having a root folder which in turn contains three 

folders named shared, system, and users. 

 

b. Open the Catalog Manager  

i. Navigate to File menu and open the catalog online (File->Open catalog) by 

giving the necessary credentials based on your setup (Type - (online), URL - 

(http://<ipaddress>:<port>/analytics/saw.dll).  

ii. Once the catalog is opened, it displays a folder structure on the left-hand side. 

Select the shared folder in the LHS tree structure.  

iii. Go to the ‘File’ menu and select ‘Unarchive’. It asks for the path for a file.  

iv. Browse the path of the archived catalog file saved in your local folder using the 

Browse button in the pop-up. Click OK.  

v. The catalog is unarchived in a specified location. A pop up for successful 

operation is displayed. Restart the presentation services once again.  

c. Open the analytics OBIEE URL- (http://<ipaddress>:<port>/analytics) and login with 

credentials based on your setup. Verify the availability of the catalog. 
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7. Configure tnsnames.ora.  

a. Open tnsnames.ora file under the folder - <Oracle Home>/network/admin.  

b. Make sure that an entry is made in the tnsnames.ora to connect to the atomic 

schema of the OFSAA application.  

c. Save the tnsnames.ora file.  

8. Configure the ODBC data source to connect to Oracle BI Server.  

a. Navigate to Control Panel>Administrative Tools>Data Sources (ODBC).  

b. Select the System DSN tab and click the Add button.  

c. Select a driver-specific to (Oracle BI Server 11g) and click the Finish button.  

d. Enter Name and Server details (specify the Host Name or IP Address of the BI 

Server) and click Next.  

e. Enter Oracle BI Server login id and password (Enter User Name and Password 

created at the time of OBIEE installation). Click Next.  

f. Click Finish.  

9. Modify the connection pool and set the properties.  

a. Open the OBI Administration tool.  

b. Select Start > Programs > Oracle Business Intelligence > BI Administration.  

c. Select File > Open > Online and select LLFPBI.rpd file. 

d. In the Open dialog box, select and open LLFPBI.rpd file. 

e. Enter the Repository password as ‘Administrator1’.  

f. In the Physical layer, double-click the Connect Pool. The properties of 

Connection Pool LLFP is displayed. 

g. In the General tab, edit / check the following entries:  

i. Call Interface: (OCI 10g/11g).  

ii. Data source name: <tnsnames.ora entry created in the step 8.b connecting to 

OFSAA atomic schema>.  

iii. User name: <enter atomic db user name>.  

iv. Password: <enter atomic db user password>.  

v. Confirm password and Click OK to close the window.  

vi. Similarly, configure the connection pools for ‘LLFPBI’. 
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NOTE:  Repeat similar steps from (g) above for connection pool 'Connection 

Pool MR' under Database 'Market Risk'.  

vii. Click Save to save the RPD file.  

viii. Click No for the Global Consistency Message.  

ix. Close the RPD file (File / Exit).  

10. Login into LLFPBI Application using the URL: http://localhost:9704/analytics.(Replace 

the port number based on your setup). 
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AAppppeennddiixx  AA  

FFrreeqquueennttllyy  AAsskkeedd  QQuueessttiioonnss  

WWhhaatt  cchheecckkss  ddooeess  tthhee  88..00..33..00..00  CCAA  RReelleeaassee  ppaattcchh  ppeerrffoorrmm??  

 Environment Check- As part of the environment check, it performs Java validation, Environment 

Variables validation, OS-specific validation, DB specific validation, and it shuts down all OFSAAI 

Services (Infrastructure Server, ICC Server, and back-end services). 

 Post Install check- As part of the Post-install check, it checks if OFSAAI services can be 

successfully started.  

WWhhiicchh  vveerrssiioonn  ooff  EERRwwiinn  DDaattaa  MMooddeelleerr  ddooeess  OOFFSSAAAAII  ssuuppppoorrtt??  

OFSAAI now supports ERwin version 9.2 and 9.5 generated XML in addition to ERwin 4.1, ERwin 7.1, 

ERwin 7.3, and ERwin 9.0 formats. 

WWhhaatt  sshhoouulldd  II  ddoo  ffoorr  vviieewwiinngg  tthhee  lloogg  ffiilleess  iinn  tthhee  DDeebbuugg  lleevveell  ffoorr  ttrroouubblleesshhoooottiinngg??  

By default, the log level is set as INFO. You need to manually change it to Debug to view the log files in 

the debug level. Based on your requirement, you can change the log level to Warn, Error, or Fatal as well. 

1. Navigate to $FIC_HOME/conf in the APP layer of your OFSAAI installation. 

 Change the priority value to Debug in the RevLog4jConfig.xml file. 

For example: 

<root>  

  <priority value ="debug" />  

  <appender-ref ref="ConsoleAppender1"/>  

</root> 

 Change the value of LOGGERLEVEL in the DynamicServices.xml file from 20 to 0. (20 

is the value for Info and 0 for Debug.) 

NOTE:  For multi-tier installation, you need to change the log level to Debug in the 

DynamicServices.xml and RevLog4jConfig.xml files, which are present in 

$FIC_APP_HOME/conf, $FIC_DB_HOME/conf, and $FIC_WEB_HOME/conf 

as well. 

2. Navigate to $FIC_WEB_HOME/webroot/conf and change the priority value to Debug in the 

ExportLog4jConfig.xml, MDBLogger.xml, and PR2Logger.xml files for viewing log files in Debug 

level for the modules Archive/Restore, Metadata Browser, and RRF respectively. 
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3. Generate the application EAR/WAR file and redeploy the application onto your configured web 

application server. For more information on generating and deploying EAR / WAR file, refer to the 

Post Installation Configuration section in OFS IFRS Pack Installation and Configuration Guide – 

Release 8.0.0.0.0, available in OHC Documentation Library. 

4. Restart the OFSAAI Services (APP and WEB). For more information, refer to the Start/Stop 

Infrastructure Services section in OFS IFRS Pack Installation and Configuration Guide – Release 

8.0.0.0.0, available in OHC Documentation Library. 

 

http://docs.oracle.com/cd/E60529_01/homepage.htm
http://docs.oracle.com/cd/E60529_01/homepage.htm
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